
  למורה-נקודות וישרים  רבות והספורטהת,  כל הזכויות שמורות למשרד החינוך©
 

 פעילות להכרת הסביבה הממוחשבת –נקודות וישרים  .1

 

 מבוא
הכרת החלון האלגברי והחלון הגרפי של התוכנה המלווה , ראשית: מטרתה של יחידת לימוד זו כפולה

קטעים וגרפים ולהוסיף כתוביות , התלמידים ילמדו לשרטט נקודות. Derive, את הפעילויות

הכנה , שנית. הצבה ופתרון משוואה, פישוט: ת הפעולותוכן לבצע בעזרת התוכנה א, לשרטוטים

ל נפגשים עם נושא זה לראשונה במסגרת " יח5תלמידי . לתחילת לימוד נושא הגיאומטריה האנליטית

. וייתכן כי כל הידע שצברו עד כה מסתכם בלימודי הפונקציה הקווית בחטיבת הביניים, 7יחידה 

ויגלו את ,  עם שיפוע של ישר לפי שתי נקודות שעליובפעילויות הבאות ייפגשו התלמידים מחדש

כמו כן יחשבו בעזרת התוכנה מרחק בין . תכונת הניצבות של ישרים תוך הפעלת משפט פיתגורס

 .כך יחזקו את הנושאים הבסיסיים הנחוצים להמשך הלימוד. שתי נקודות ושטח משולש לפי קדקודיו

שאליהן ישובו גם , גם לאפשרויות התכנות של התוכנהבמהלך הפעילות ביחידה זו ייחשפו התלמידים 

נציין כי התכנות בסביבה . הם יגדירו למחשב פונקציות לביצוע ויפעילו אותן. ביחידות הבאות

ולצורך תכנות נוסחה דרושה הבנה עמוקה של המתמטיקה , הממוחשבת נשען על הידע המתמטי

 . מטיקהעם התוכנה בשפת המת' משוחח'המשתמש . המובילה אליה

הפעילות מובילה את . הוכחת תכונות גיאומטריות בשיטות של גיאומטריה אנליטית: עוד ביחידה זו

כאן . ומלווה אותו בהוכחת משפט ישר והפוך בדרך אנליטית, התלמיד מן המקרה הפרטי אל הכללי

רה הכללי ובמק,  לבדיקת ההוכחה על ידי שרטוט תואם–במקרה הפרטי . רב כוחו של הכלי הטכנולוגי

 .   לפישוט ביטויים ארוכים ומרובי משתנים-

 

 ועם מסמכי   Wordאחרי ההסברים ליחידה זו מוגשות הנחיות טכניות לארגון העבודה עם מסמכי

Derive .   

 

 
 :רשימת הפעילויות

 משולש ישר זווית – 1.1פעילות 

 ישרים ניצבים – 1.2פעילות 

 ניצביםמכפלת השיפועים של ישרים  – 1.3פעילות 

 הוכחת ההשערה – 1.4פעילות 

 ?איפה הקדקוד – 1.5פעילות 

 שטח של משולש – 1.6פעילות 
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 . והיא תעזור לנו ללמוד הנדסה אנליטיתDeriveהסביבה הממוחשבת נקראת 

 
 

 .Deriveבטבלה שלפניכם נפרט את סימון המושגים בתוכנה 

 

 הערות Deriveסימונים ב  מושגים

  A:= [a1, a2] נקודה במישור

 [A, B] קטע
לשרטוט קטעים 

 4' ומצולעים ראו עמ

   |B - A| אורך קטע

סימן הערך המוחלט 

משמש לחישוב מרחק 

 5' ראו עמ. בין נקודות

 שיפוע

פונקציה המוגדרת על 

 :ידי המשתמש

SLOPE(P, Q) 

ראו הסבר והגדרה 

 6' בעמ

 

 
 : שלההחלון האלגברי מתקבל Deriveעם פתיחת התוכנה 

 . במסך או בשורת העריכהאהסמן יכול להימצ: מו לב למקומו של הסמןשי

 

 
 
 

 
 
 

תפריט ראשי
 סרגל הפקודות

שורת העריכה
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 משולש ישר זווית  – 1.1 פעילות

 : הםABCקדקודי משולש  .א

 A:= [-2, 6] 

 B:= [4, -2] 

 C:= [1, 7] 

 

 .רשמו את הנקודות בחלון האלגברי 
 :רישום ביטוי על המסך 

העבירו את העכבר , אם הסמן אינו בשורת העריכה. (ריכהרישום ביטוי נעשה כאשר הסמן נמצא בשורת הע

 .)לשורת העריכה והקליקו עליו

 A:= [-2, 6]       הקלידו  

 . כדי להעביר את הביטוי לחלון האלגבריEnterהקישו  

  בחלון האלגברימחיקת ביטויים 

 (Delete)  סמנו את הביטויים והקליקו            –למחיקת ביטויים בחלון האלגברי 
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 .ברצוננו לשרטט את המשולש

 
 

 :וחלוקה אנכית של המסך) דו ממדי(פתיחת חלון גרפי 

 . לפתיחת חלון גרפיהקישו על 
 . החלון הגרפי יופיע לצד החלון האלגברי– Tile Vertically בחרו Windowמתפריט 

 
 .נעשה על ידי הקשה עם העכבר) או שורת העריכה(מעבר בין החלונות 

  
 :שרטוט נקודות וקטעים

 לעבור לחלון הגרפי   עלבחלון האלגברי והקישו A הנקודה סמנו בעזרת העכבר את: רטוט נקודהש

 . לשרטוט הנקודה(Plot)  ושוב הקישו 
 
בשורת העריכה את כל הנקודות  רטט קבוצת נקודות בפעולה אחת רשמושכדי ל: רטוט קבוצה של נקודותש

רטטו שולהעברת הכתוב למסך Enter הקישו  [ A, B, C ] כאשר ביניהן פסיקיםבתוך סוגריים מרובעים  

 . 
 כלומר יש לעבור ,הנקודות מחוברות רטט אתש יש ל–רטוט צלעות המשולש של:  בין נקודותיםרטוט קטעש

 .Connectלמצב 
 

 :Connect  מעבר למצב
 .Optionsבחרו בתפריט החלון הגרפי  ב 

 .Connect לגבי האפשרות Yes אשרובחלון שנפתח . Pointsבחרו  ובו Displayבתפריט שנפתח בחרו ב 
 .Smallבחרו . Small ,Medium ,Large: תוכלו לשנות את גודל הנקודות לפי האפשרויות

 .ושרטטו  ) רכדי שהמשולש ייסג ([ A, B, C, A ]עתה רשמו 
 

הוסיפו את . תקת הביטוי לשורת העריכה להעF3 והקישו [A, B, C]סמנו את השורה בה רשום : הצעת ייעול
 .Enterהדרוש והקישו 
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 :התאמת מערכת הצירים

   להתאמת גודל היחידות על מערכת הצירים בחלוןהשתמשו ב , כדי לראות את המשולש כולו

 .יהגרפ

 

 :י אותיות"רטוט עשסימון נקודות ב
 כתוביתהקליקו עם העכבר בנקודה בה ברצונכם להוסיף 

 

      .  Insert Annotation השתמשו ב  וביתכתלהוספת 
 .והצבע הרצוי, Font תבחרו את סוג האותיות השיחה תתיבב

 .ניתן להזיזה ולשנות את מיקומה, אחרי כתיבת האות בחלון הגרפי
 

 .Edit סמנו את הכתובית עם העכבר והיכנסו לתפריט –לשינוי כתוביות או מחיקה 
 

 ידי -מחיקת שרטוטים על

 
 : שרטוט מהחלון הגרפי לחלון האלגבריהעברת

 .תוכן החלון הגרפי יעבור לחלון האלגברי. Embedבחרו ) בחלון הגרפי (Fileמתפריט 
 .בהקלקה על התמונה בחלון האלגברי יפתח החלון הגרפי עם התמונה

 )Updateאפשר לעדכן את התמונה בעזרת הפקודה (
 

 .ריהגדילו את החלון האלגב. סגרו את החלון הגרפי

 
 ===="1.1b"====  הקליקו בתוך גרשיים :רשמו קו הפרדה' לפני שתעברו לסעיף ב

 
 ".ערך מוחלט" נשתמש בABלחישוב אורך הקטע  .ב
 

 abs(B - A)      (Enter)=     או    |B - A|= הקלידו     
 

             :הקישו| להקלדת סימן של ערך מוחלט 
  B - A| = 10| :על המסך יירשם

 

 ).תוכלו להיעזר במשפט פיתגורס( הוא ישר זווית ABCהראו כי המשולש  
מעל סימן (של התוכנה  וגם בסרגל הסימנים המתמטיים,  בלוח המקשים6סימן החזקה נמצא מעל הספרה 

     ).השורש
 

 

 

 

 1.1פתרונות והסברים לפעילות 
 dfw..11solution: ראו גם קובץ

 

 A] : -2, 6:   [שימו לב לאופן סימון הנקודות. א

 ". Connect"ולבחור את המצב ] B ,A: [יש להקליד , ABכדי לשרטט את הקטע   

 ]B, C, A ,A[: לסגירת המשולש יש להקליד

 
   A  - B| = 10|  : חישוב ערך מוחלט. ב

   A - B|2+|B - C|2 = 100|:  נבדוק אם מתקיים משפט פיתגורס

 name1.1.dfw, שמרו את הקובץ שבניתם בשם שלכם 
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  ישרים ניצבים – 1.2פעילות 
 
∠=°,   הוא משולש ישר זווית ABCמשולש  .א 90c 

 C:=[5,0]    A:=[-3,4]:   הםACקצות הניצב  

   B:=[2, y]:לדוגמה, B , חפשו נקודה מתאימה לקודקוד החסר, כדי להשלים את המשולש 

 .yו משוואה מתאימה כדי למצוא את ערכו של היעזרו במשפט פיתגורס ורשמ 
 

 :פעולות בחלון האלגברי

 .   (Simplify)  לפישוט ביטוי בחלון האלגברי הקישו 

בחרו , אם במשוואה יותר מנעלם אחד ייפתח חלון  .  (Solve) לפתרון משוואה בחלון האלגברי הקישו 

 .Solveאת הנעלם שברצונכם לבודד והקישו על 

 . B אחרת עבור הקודקוד מצאו נקודה

  B?מה הקשר בין הנקודות שמצאתם עבור הקדקוד 

 ===="b1.2"====  הקליקו בתוך גרשיים :רשמו קו הפרדה' לפני שתעברו לסעיף ב

 

 B :    B:=[x, y]סמנו את שיעורי הקודקוד .  ב

 .  נמצאות על ישר אחדBהראו כי כל האפשרויות לסימון הקודקוד  

 . הישר והוסיפו אותו לשרטוטכתבו את משוואת 

 
 ===="c1.2"====  הקליקו בתוך גרשיים :רשמו קו הפרדה' לפני שתעברו לסעיף ג

 

 ?  מונח עליוBCמהו שיפוע הישר שהניצב .  ג 

 ?ACמהו שיפוע הניצב הנתון  

 

 :הגדרת פונקצית השיפוע

נגדיר לתוכנה את פונקצית ,  שעליוQ  -  וP לפי שתי הנקודות y)שאינו מקביל לציר (לחישוב שיפוע של ישר 

: המחשבת את מנת ההפרשים) SLOPE(השיפוע 

12

12

xx
yym

−
−

=.  

     P↓2 :  של הנקודה רשמוY-ולסימון שיעור ה P↓1:   רשמוP של נקודה X-לסימון שיעור ה 

 .תמצאו בסרגל הסימנים בתחתית המסך  ↓את מקש החץ 

:  רשמו בשורת העריכה
11
22

↓−↓
↓−↓

QP
QP

   SLOPE(P,Q):=  . הקישוEnter .  עתה פונקצית השיפוע

 . מוגדרת
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 ?מהו הקשר בין שיפועי הניצבים: סכמו

 
 

 ==="d1.2"====  הקליקו בתוך גרשיים :רשמו קו הפרדה' לפני שתעברו לסעיף ד

 

 

 .___: מכפלת השיפועים של ישרים ניצבים היא: השערה .ד

 .כרצונכם, חזרו על התהליך לגבי משולש ישר זווית אחר 

 , )ABC קודקוד הזווית הישרה במשולש C( כרצונכם ACבחרו את קצות הניצב  

 .  בעזרת משפט פיתגורס, BCמצאו את הישר שעליו מונח הניצב  

 .הניצביםחשבו את מכפלת השיפועים של שני  

 

 

 

 
 

 

 

 
 
 

 name1.2.dfw, שמרו את הקובץ שבניתם בשם שלכם 
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 1.2פתרונות והסברים לפעילות 
 dfw..21solution: ראו גם קובץ

משפט : מטרת הפעילות היא גילוי נוסחת הניצבות של ישרים בזיקה לידע הקיים של התלמידים

מסייעת פעילות זו להעמקת , כמובן, במקביל. וויתפיתגורס כתנאי הכרחי ומספיק למשולש ישר ז

 . באופן מדורג ובהיר, ההיכרות עם האפשרויות הגלומות בתוכנה

 :סימון הנקודות. א

 
 נותן את השיעור החסר של yופתרונו לפי , כתיבת שוויון לפי משפט פיתגורס במשולש ישר זווית

  :Bהקדקוד 

 
 :עתה אפשר לשרטט את המשולש המבוקש

 

 
עבור , ונשרטט את המשולש ישר הזווית שהתקבל, B אחר לקדקוד xנחזור על הפעולה עבור שיעור 

  .ACאותו ניצב 

 

 הוא Bהמקום הגיאומטרי של כל הנקודות המתאימות לקדקוד החסר : הכללת הפעילות הקודמת. ב

 .קו ישר

נפתור ( כנושא הנוסחה   y את ונציג, נפשט אותו, נציב שוויון לפי משפט פיתגורס, נגדיר נקודה כללית

  ):yלפי 



 

  למורה-נקודות וישרים  התרבות והספורט,  כל הזכויות שמורות למשרד החינוך©
 

9

 

 
 :הנה השרטוט המתאים

 
 
 :וחישוב שיפועי הניצבים, תכנות פונקצית שיפוע לפי ההוראות. ג

 

 
 .-1מכפלת השיפועים היא :  מצאנו קשר בין שיפועי הניצבים

 
 .בחירה חופשית של הקדקודים וחזרה על אותו תהליך. ד
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 יפועים של ישרים ניצבים מכפלת הש– 1.3פעילות 
 

AB הוא היתר במשולש ישר זווית ABC.  

 A:=[-2, 0]     ,  B:=[2, -3]: ידי- נתונים עלB - וAשיעורי הנקודות 

y:     מונח על הישרBCהניצב  2x 1= − +.   

  C    :C:=[x, -2x+1]נסמן את קדקוד הזווית הישרה . א

 . רת משפט פיתגורס בעזCחשבו את שיעורי הקדקוד 

 .בדקו את תשובתכם לפי מכפלת השיפועים של ישרים ניצבים. ב

 

 

 
 
 

 1.3פתרונות והסברים לפעילות 
 dfw..31solution: ראו גם קובץ

 
 :ונח עליו מBC ואת הישר שהניצב ABונשרטט את הניצב , נסמן את הקדקודים. א

 

 
 :ונפתור את המשוואה שהתקבלה, נפשט, נכתוב שוויון לפי משפט פיתגורס

 

 

  name1.3.dfw, שמרו את הקובץ שבניתם בשם שלכם 
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 ?מה משמעות הפתרון השני

.  של קודקוד זהyעתה נחשב את שיעור ה . C,   של קודקוד הזווית הישרהxמצאנו את שיעור ה 

 .)#2וגדרו בשורה ה,  y = -2x + 1שנמצא על הישר הנתון ושמשוואתו היא , Cשיעורי קודקוד (

  
 :אפשר לשרטט עכשיו את המשולש

 
 :נגדיר לתוכנה את פונקצית השיפוע ונחשב בעזרתה את מכפלת שיפועי הניצבים. ב
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  הוכחת ההשערה– 1.4פעילות 
 
 . נשתמש בשיטת הוכחה אנליטית להוכחת המקרה הכללי. א

 .  שניצביו אינם מקבילים לצירי המערכתABC ת   במשולש ישר זוויA , B   סמנו את הנקודות  

 .C    קדקוד הזווית הישרה הוא 
 :סימון נקודה כללית

1: לדוגמה, לסימון שיעורי נקודה באופן כללי 2A : [a ,a a1:=, a2:  נגדיר תחילה את השיעורים,  =[ ורק  ; =:

 .A להשתמש בהם לסימון הקודקוד אחר כך נוכל

 

השתמשו בקשר .  x באמצעות yהביעו את ,  לפי משפט פיתגורס y  - לxמצאו את הקשר בין 

סמנו שברצונכם , SOLVE) (היעזרו בפקודה .  BC  ו ACשמצאתם לחישוב שיפועי הניצבים 

 . yלפתור עבור 

 :הצבת משתנים

בתיבה שתיפתח  , (Variable Substitution) הקישו להצבת ביטוי או מספר במקום אחד המשתנים 
 . האירו את המשתנה הנבחר וכתבו את הערך שתרצו להציב במקומו

 ?מהי מכפלת השיפועים של שני הניצבים

 :נסחו מסקנה

 ____________) שניצביו אינם מקבילים לצירי המערכת(הוכחנו כי בכל משולש ישר זווית 

ובכך הוכחנו ,  של שני ישרים ניצבים כעל קדקוד זווית ישרהנוכל להסתכל על נקודת המפגש

   .1-: מכפלת השיפועים של ישרים ניצבים היא: משפט בהנדסה אנליטית

 .______________ אז _____________________   אם :  ובניסוח אחר

 .נבדוק אם גם המשפט ההפוך נכון. ב

 __  _________________________אם : נסחו משפט הפוך

 .  ________________________       אז    

   .הוכיחו את המשפט בשיטה של הנדסה אנליטית
 

 

  name1.4.dfw, שבניתם בשם שלכםשמרו את הקובץ  
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 1.4פתרונות והסברים לפעילות 
 dfw..41solution: ראו גם קובץ

 

1ראשית עלינו להגדיר לתוכנה את המשתנים  .א 2a ,aוכו   ,' 

  :A, C         ובעזרתם נוכל להגדיר את הקדקודים 

 
  ):yנפתור לפי (  כנושא הנוסחה yונביע את , נפשט אותו,      נכתוב שוויון על פי משפט פיתגורס

 
,  ABC של המשולש הכללי Bמצאנו משוואת ישר שהוא המקום הגיאומטרי של כל הקדקודים 

 .וד הזווית הישרה הוא קדקCכאשר 

ונבטא בעזרתה את , )אם היא עדיין אינה מוגדרת בקובץ זה(נגדיר מחדש את פונקצית השיפוע 

 :שיפועי הניצבים

 

 
 

 

 

 

 

 

 :ונפשט, )#7שורה (  את הביטוי שקיבלנו עבורו ממשפט פיתגורס yבמקום נציב בביטוי האחרון 
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שלים את ההוכחה בשיטת ההנדסה ובכך נ, עתה נבדוק מהי מכפלת שיפועי שני הניצבים

 :האנליטית עבור משולש ישר זווית כללי

 
  .-1בכל משולש ישר זווית מכפלת שיפועי הניצבים היא : מסקנה

  .-1אז מכפלת שיפועיהם היא , אם הישרים ניצבים זה לזה: ובניסוח אחר

  
 .נכים זה לזהאז הישרים מאו , -1אם מכפלת השיפועים של שני ישרים היא :   משפט הפוך .ב

 :הוכחת המשפט בשיטת ההנדסה האנליטית

  היא BC ו ACונציב בתור נתון כי מכפלת שיפועי הצלעות , נגדיר את המשתנים היוצרים משולש

 . עלינו להוכיח כי צלעות אלו הן ניצבים במשולש ישר זווית . -1

 
 : כנושא הנוסחה yונביע את, נפשט את המשוואה האחרונה

 

2:  בפישוט שני אגפי השוויון, יים משפט פיתגורסנבדוק שמתק 2 2A C B C A B− + − = −    

 .  הוא ישר זווית ABCהמשולש : כלומר. מתקבלים ביטויים זהים

 .בכך הוכחנו כי גם המשפט ההפוך נכון

 .-1ישרים מאונכים אם ורק אם מכפלת שיפועיהם היא : נוכל לסכם

 .)ם לציריםישרים המקבילי: שימו לב למקרה החריג(
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 ? איפה הקדקוד–1.5פעילות 
 

BD הוא אלכסון במלבן ABCD. 

 D:=[-4 ,3]    B:=[4, -3]:   ידי-  נתונים עלD  ו Bשיעורי הקדקודים 

 C:=[5 ,y]:   הואCקדקוד הזווית הישרה 
 
 .Cל הקודקוד שy  מצאו את שיעור ה . א
 
 .A, מצאו את הקדקוד החסר. ב

 . אכן מלבן הראו שהמרובע שקיבלתם הוא

 .  ג-וחיזרו על סעיפים א, )?האם קיימת מגבלה(כרצונכם , C אחר לקדקוד  xבחרו שיעור . ג

 .   שרטטו את המלבן שבחרתם

 ?  הוא האלכסוןBDכמה מלבנים שונים תוכלו לשרטט כך ש  

 ?C של הקדקוד  xמהי המגבלה על בחירת שיעור  . ד

 ?C  של הקדקוד y  אלו ערכים יכולים להתקבל עבור שיעור  

 

 

 
 1.5פתרונות והסברים לפעילות 

 dfw..51solution: ראו גם קובץ

 –בד בבד נחשפים התלמידים . מטרת הפעילות היא שימוש במשפט שנוסח והוכח בפעילות הקודמת

בבואם לשרטט את כל המלבנים בעלי אלכסון , ומטרימקום גיא למושג –עדיין באופן אינטואיטיבי 

 . מסוים

 :נגדיר את קדקודי המלבן .א

 

 
 :נגדיר מחדש את פונקצית השיפוע

 
אם אינן מקבילות   (CB  ו CD, ולכן מכפלת שיפועי הצלעות הסמוכות, זוויות המלבן ישרות

   :-1היא ) לצירים

 
 :נפשט את המשוואה שקיבלנו ונפתור אותה

 
 

  name1.5.dfw, שמרו את הקובץ שבניתם בשם שלכם 
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 ]C] :0 ,5יבלנו את שיעורי הקודקוד ק

 

 ]-5, 0: [ הםAמנימוקי סימטריה נוכל להראות כי שיעורי הקדקוד  .ב

 :  הוא אכן מלבן בדרכים שונותABCDנוכל להוכיח כי המרובע 

 .)מרובע שכל זוויותיו ישרות הוא מלבן . (1-מכפלת שיפועי כל זוג צלעות סמוכות היא : למשל

 : הנה המלבן

 
 C:=[2, y], למשל. C  שונה לקודקוד xשיעור  התהליך עבור נחזור על .ג

 .נדון במגבלות בסעיף הבא,  אך יש מגבלות–נוכל לבחור אינסוף קדקודים כאלו 

      

 .y לא יתקבל פתרון ממשי עבור  לא יתקבל פתרון ממשי עבור C:=[6, y]אם נבחר  .ד
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, רי של הנקודות שמהן רואים את האלכסון הנתון בזווית ישרהאנו מחפשים את המקום הגיאומט

 .  הוא היתר שלוBDאת כל הקדקודים האפשריים של משולש ישר זווית שהקטע הנתון : כלומר

   . -1 היא   BC  ו CDמכפלת השיפועים של הניצבים  : נציב

y 3 y 3 1
x 4 x 4
+ −

⋅ = −
− + 

 

המתקבלות כאשר   למי ששכח את הנקודותבשרטוט גרף המשוואה לעיל מזכירים" חורים"ה

 .סביב קצות הקטע" חורים" שימו לב גם ל.(4,3) (3- ,4-)  הצלעות מקבילות לצירים

2:   קוטר  BDידי פישוט קיבלנו את משוואת המעגל שבו -על 2x y 25+ = 

 

 

 

כל הנקודות על .  קוטרהמקום הגיאומטרי מתאים למשפט הידוע אודות זווית היקפית הנשענת על

אלכסון (משמשות כקדקודי זוויות ההיקפיות הנשענות על הקוטר ) מלבד קצות הקוטר(המעגל 

  .BD)  המלבן

 
 . תהיה מחוץ למעגלCשכן אז הנקודה | , 5|   הגדול מ  xכמובן שלא נוכל לבחור שיעור 

 y≥5כך ש , yמאותו טעם יתקבלו ערכי 
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  שטח של משולש –1.6פעילות 
 

 A:=[-4 ,6]    B:=[8, 1]   C:=[3, -2]:    הםABCקדקודיו של המשולש 

 .ר" יח30.5הראו כי שטח המשולש הוא 

 .ובחרו אלו מהם כדאי לבצע בעזרת התוכנה, תחילה רשמו את שלבי הפתרון

 
 

 

  

 

 1.6פתרונות והסברים לפעילות 
 dfw..61solution: בץראו גם קו

מרחק נקודה מטרת הפעילות היא שימוש בידע הקיים עד כה בגיאומטריה אנליטית כהכנה לנושא 
נדרש התלמיד לחשב את אורך הגובה מקדקוד המשולש , בבואו לחשב את שטח המשולש. אל ישר

כאן יבצעו התלמידים את כל . ל הקדקוד מן הצלעעליו לחשב את מרחקו ש, למעשה. אל הצלע שמולו

 .כשיחתרו לקראת הנוסחה לחישוב מרחקה של נקודה מישר, השלבים שאליהם יידרשו בהמשך

 .ולשקול אלו מהם כדאי לבצע בעזרת התוכנה, בפעילות זו מומלץ לתכנן מראש את שלבי הפתרון

 : נשרטט את המשולש 

 

 
 : שלבי הפתרון

ונבדוק על ידי שרטוט בעזרת , נחשב ידנית (B ו Aת הישר העובר דרך הנקודות מציאת משווא) 1

 ). מונח על הישר שמצאנוABהתוכנה שהקטע 

 ושיפוע הגובה לפי C  לפי שיעורי הנקודה AB לצלע Cמציאת משוואת הגובה היורד מהקדקוד ) 2

 .תכונת מכפלת שיפועי האנכים

 name1.6.dfw, שמרו את הקובץ שבניתם בשם שלכם
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לפתרון מערכת . ש של הגובה עם הצלע שאליה הוא יורד נקודת המפג-  Mחישוב שיעורי נקודה ) 3

 .ניעזר בתוכנה, שתי משוואות בשני נעלמים במספרים לא שלמים

 . חישוב שטח המשולש בעזרת התוכנה המחשבת בקלות אורכי קטעים) 4

 

 :הפתרון

 : לפי שני קצותיהABמשוואת הצלע ) 1

 
 5/12 –  לפי מכפלת השיפועים– הוא ABשיפוע הגובה לצלע ) 2

 :C, משוואת הגובה המבוקש לפי השיפוע והנקודה שממנה הוא מורד

 
 ,AB עם הצלע C את נקודת המפגש של הגובה היורד מקדקוד Mנסמן ב ) 3

 :נחשב את שיעוריה

את  SOLVE) (ונבחר בפקודה  , ": וגם"לפתרון מערכת משוואות נשתמש בסימון 

 .המשתנים שאותם אנו מעוניינים למצוא

 .'בלתי נוחים'כות התוכנה אין כל קושי לעבוד עם מספרים בז

 

 
 :עתה נמצאים בידינו כל הנתונים הדרושים לחישוב שטח המשולש) 4

 
 .ובכך הוכחנו את הנדרש

 . מן המקרה הפרטי אפשר לעבור למקרה כללי
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וד בלימ. אך ורק בעזרת הכלים שנרכשו עד כה, נמצא נוסחה לחישוב שטח משולש לפי קדקודיו

 כשילמדו נוסחה לחישוב מרחק בין –ובהמשך , הנושא וקטורים בוודאי ייחשפו התלמידים לנוסחה זו

פעילות זו מהווה אם כן הכנה טובה .  יוכלו לייצר את נוסחת שטח המשולש ביתר קלות–נקודה לישר 

 .לפרקים הבאים

 "משולש כללי"תחילה נגדיר את המשתנים של 

 
לא נירתע כיוון , למרות שמדובר בביטויים עתירי משתנים.  בסעיף הקודםנחזור על השלבים שביצענו

 .אתם עבורנו" תעבוד"שהתוכנה 

 :ABמשוואת הצלע 

 
 

 
 :CMמשוואת הגובה 

 
 :נקודת המפגש של הצלע עם הגובה המורד אליה, Mנחשב את שיעורי הנקודה 
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 : הםMשיעורי הנקודה 

 

 
 :י שלושת קדקודיועתה נביע את שטחו של המשולש לפ
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 Word ושילובם עם קבצי Deriveהדרכה לעבודה עם קבצי 

 
 של התלמידים ניתן ללמוד רבות אודות הבנתם ואודות דרך Derive -מתוך קבצי הפתרונות ב

 . ולבחון אותם בעיון, מומלץ לאסוף את התוצרים משיעורים המלווים בפעילויות מחשב, לכן. עבודתם

להוסיף עליהם הסברים בכתב ולהגישם , התלמידים להדפיס את הקבצים שלהםאפשר לבקש מ

בדומה למוצע , תלמידים אחרים יעדיפו להוסיף את הערותיהם ואת הסבריהם ישירות לקובץ. למורה

 .בקבצי הפתרונות המלווים את הפעילויות

  
  ?איך מוסיפים כיתוב

 .בריםוהקלידו הס (Insert Text)              לחצו על 

 

   Shift+Ctrl. לחצו  בצד ימין על , לכתיבה בחלון האלגברי בעברית

 בחרו. תוכלו לבחור את סוג הגופן ואת גודלו

Windows> View Toolbars > Formatting Toolbar 

 .) Arial 11 בקבצי הפתרונות המלווים את הפעילויות השתמשנו ב  (

 

 ?גבריאיך מעבירים שרטוט מהחלון הגרפי לחלון האל

 File > Embedבחרו 

 .לחיצה כפולה על השרטוט המשובץ בחלון האלגברי תפתח אותו מחדש

 File > Updateלעדכון השרטוט בחרו 

 

 ?איך מדפיסים את תוכן החלון

 File > Printבחרו ) האלגברי או הגרפי(להדפסת כל תוכן החלון 

 

  ?eDeriv  תוכן מתוך חלונות מקבצי Word איך משלבים במסמכי 

 : ובחלון שנפתח בחרוEditבחרו ,  Word למסמך Deriveלהעתקת שרטוט מהחלון הגרפי של 

Copy Plot Window 

 . כתמונה,   או לכל מקום אחרWordלהעתיק את השרטוט למסמך " הדבק" עתה תוכלו בעזרת הפקודה 

  מסגרו את Edit > Mark and Copy.) בסרגל הכלים של החלון האלגברי או הגרפי(בחרו : אפשרות נוספת

תוכלו לערוך את התוכן שהעתקתם ". הדבק" בעזרת הפקודה Wordשלבו במסמך  , התוכן שברצונכם להעתיק

 . כתמונה

 

 
 


